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End User License Agreement 

In the End-User Agreement below, the following terms are employed with these definitions: 

 The End-User is the person or entity that has purchased the Software and is using it in the 
course of its business. 

 An Affiliate is a legal entity directly or indirectly controlling, controlled by or under common 
control with an End-User. Control of an entity shall exist through the direct or indirect: 

a) control of 50% or more of the nominal value of the issued share capital of the entity or of 50% or 
more of the entity's shares entitling the holder to vote for the election of directors or persons 
performing similar functions, 

or 

b) right by any other means to elect or appoint directors of the entity (or persons performing similar 
functions) who have a majority vote. 

 The Software is the application program and related programs including the speech quality 
metric(s) and firmware that have been supplied to the End-User and have been installed from 
the original media along with any product enhancements supplied by Malden Electronics 
Limited and come into being upon a single computer platform that is connected to a single 
Digital Speech Level Analyser (DSLA). 

 

By installing and using the Software the End-User agrees to the following: 

1. The Software and firmware shall only be used in conjunction with the DSLA. 

2. One instance of the Software may be caused to come into being on one computer platform. 

3. The Artificial Speech Test Stimulus (ASTS) may only be used for the purpose of making a measurement or a 
sequence of measurements, as part of which at least one such copy of the ASTS shall be processed through 
the Software. No more than five simultaneous copies of the ASTS may be being generated at any one time. 

4. The End-User shall not copy the Software in whole or in part, other than is essential for the proper operation 
of the Software or for normal security back-up purposes. 

5. The End-User shall not modify, translate, reverse-engineer or decompile the Software except to the extent 
permitted by law. 

6. The End-User shall maintain the Software in confidence and ensure that it is protected from unauthorised 
copying or disclosure by measures that are no less stringent than those it uses to protect its own valuable 
information and that are, in any case, no less than reasonable in the circumstances. 

7. The End-User shall prohibit the use of the Software by anyone other than the End-User, its employees and 
agents. 

8. The acknowledgement of the rights in the Software shall not be removed from the Software or any installation 
of it 

9. The End-User shall not transfer or assign the End-User Agreement except to an Affiliate of the End-User. 

10. The validity construction and performance of this Agreement shall be governed by and interpreted in 
accordance with the laws of England. 
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Introduction 

What is the DSLA? 
The Digital Speech Level Analyser is a true RMS voltmeter which measures mean active 
speech level in accordance with ITU-T Recommendation P.56 Method B.  This technique 
provides accurate and repeatable measurements of the energy or amplitude of complex 
discontinuous signals found in telecommunications and signal processing applications.  

The DSLA generates any speech signal to stimulate networks and network elements, in 
particular an Artificial Speech Test Stimulus (ASTS) in different languages. 

 

Options include: 

 An Artificial Speech Test Stimulus (ASTS). 

 The Perceptual Analysis/Measurement System (PAMS) providing a prediction 
of Listening Effort and Listening Quality mean opinion scores. 

 Perceptual Evaluation of Speech Quality (PESQ) – ITU-T Rec. P.862 and 
mappings to LQO P.862.1 and PESQ-WB P.862.2 

 Perceptual Speech Quality Measurement (PSQM) – (was ITU-T Rec. P.861) 

 Sound file equalisation. 

 DTMF analysis. 

 

 

© Malden Electronics Ltd 2005 
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Getting Started 

1. Unpack the DSLA and its power supply. 

2. Check that the units are undamaged. 

3. Connect the power supply jack to the jack socket on rear panel of the DSLA. The power 
supply unit provided will accept any AC mains supply in the range 90 to 260 volts, 50 or 
60 Hz.  A red LED on the front panel will light when power is applied to the unit. 

• If the mains power connector on the end of the power cable is not appropriate for 
connection to the type of socket in use, it may be changed. The mains power lead has 
three cores; Brown is live, Blue is neutral and Green/Yellow is earth. Ensure that the 
correct connections are made to the mains power connector. The Brown wire should 
connect to live supply or the terminal marked L. The Blue wire should connect to 
neutral or the terminal marked N. The Green/Yellow wire should connect to earth or 
terminal marked E or with the earth symbol. Connect the mains power lead to the 
power supply unit.  

4. Install the software supplied as described in: Installing the Software. 

5. Connect the DSLA to your PC. (See: Connecting a DSLA to your PC). 

6. A monitor output is provided on 4mm banana connectors and a 3.5mm headphone socket.  
The monitor output is capable of driving headphones or amplified speakers. 
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Installing the Software 

System Requirements 
Before you install the product, you should make sure that your computer meets the minimum 
system requirements. 

 Windows 2000/XP. 

 Pentium-class PC (200 MHz or higher recommended) 

 64 megabytes of RAM 

 Screen resolution of 1024 x 768 @ 16 colour quality recommended 

 DirectX 8.1 or higher recommended 

To install the software 
1. Insert the CD in the CD-ROM drive.  The installation process should start automatically, 

if however it does not, follow these steps: 

• From the Windows Start Bar, click Run. 

• Type <DRIVE>:\SETUP.EXE where <DRIVE> is the CD-ROM drive you are using 
and click OK. 

2. The setup program prompts you through the installation process.  Follow the instructions 
on the screen.   

Notes 
• You should exit all applications before running the setup program for software 

installation. 

• The Quickstart Schedules and Playlists are structured for operation from the C: drive. 
If you have installed the software on another drive, it is helpful initially to have a copy 
of the Playlists folder in C:\Program Files\DSLA. 
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Using DSLA 

Connecting a DSLA to your PC 
To control the DSLA, it must be connected to your PC via a standard RS232 serial port, or to 
your LAN using the Ethernet TCP/IP connection.  The default connection setting is to use a 
serial port connection. 

If you wish, you may leave the DSLA connected via both serial and LAN connections, 
although only one control method is in use at any one time. 

When using a LAN connection, the DSLA will be assigned an IP address via DHCP if a 
DHCP server is present.  If your LAN does not use a DHCP server, you must manually assign 
the DSLA an IP address.  

The current DSLA connection status is displayed in the lower left corner of the DSLA 
application’s status bar. 

To connect a DSLA to your PC 
1. Do one or both of the following: 

• Connect the DSLA to your PC’s serial port using the supplied 9 way serial lead. 

• Connect the DSLA to your PC’s Ethernet connection using the supplied lead, or to 
your LAN using a standard Ethernet lead (not supplied). 

2. Power up the DSLA. 

3. Start the DSLA application. 

4. On the Tools menu, click Options. 

5. Do one of the following: 

• To use a serial connection select the Use Serial Port option. 

• To use a LAN connection, click the Browse button and select the DSLA you wish to 
connect to. 

6. Click OK. 

To manually assign an IP Address to the DSLA 
1. Establish a serial connection to the DSLA. 

2. On the Tools menu, click Options. 

3. In the IP Address box, enter the IP address you want to assign to the DSLA. 

4. Click OK. 

5. Click Yes to the ‘DSLA IP Configuration’ dialog box that appears. 
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Signal Connections 
Each channel has two identical sets of signal connections.  The telephone jacks enable the 
DSLA to behave as a telephone; it can go off-hook, dial DTMF strings, output speech and 
measure the incoming signal.  The 4mm connections provide a 4-wire connection point, i.e. 
an input and output.  Finally, the Handset Port is an RJ22 type connector and enables simple, 
reliable connection to any microphone/earpiece device, including digital telephone (IP phone) 
handset, cellular phone handsfree port, PC microphone/line out jacks. 

The measurement input is selected in the Channel Window status bar.  The output is always 
present on both the telephone jack and the 4mm connector of each channel and is switched to 
the handset port when selected.  It is possible for the DSLA to measure the signal on the 
telephone line on the 4mm inputs in high impedance mode.  Characterisation of the line is 
easily performed in this way. 

The 4mm connectors have accurate 600 ohm terminations. The telephone jacks are 600 ohm 
terminated but the signal developed across the phone line will be dependent upon the 
impedance presented by the phone line and line card at the switch. There is a complex 
impedance termination for the telephone jacks. The impedance is 270 ohms in series with 
150nF paralleled with 750 0hms. The output impedance of the handset port is 25 ohms. 

DSLA was designed to generate speech signals. The peak to mean ratio of speech is typically 
15-18dB so the DSLA will generate speech at 0dBm mean active speech level, with some 
headroom. The balanced outputs on each channel provide a clean signal at these (and lower) 
levels. 

The telephone connections apply the signal directly to the network which clips around +8dBm 
(or less). The mean active speech level on the network is about –26dBm, depending upon the 
country and specific network types.  The DSLA can generate a –20dBm mean active speech 
level signal, which will appear on the network at an appropriate level depending upon the 
network loss plan. 

 

DSLA with Handset Front Panel Signal Connections 

 

 

 

 

 
 

4-wire Balanced  
In / Out 

Telephone LineTelephone 
Handset Port 

Monitor 
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Examples of signal connectors 
Analogue Connection DSLA Port Connectors 

Telephone Network Telephone Line RJ11 

Telephone Handset Port Telephone 
Handset 

RJ-22  

PC Sound Card Line In / Line Out 4-wire Balanced Type C 

PC Sound Card  Mic In / Line Out Handset Type A + Type B 

Cellular Telephone Handset Type B + suitable handsfree/2.5mm 
adaptor available from cellular 
accessory retailers 

Acoustic Test System (Head & Torso 
Simulator; Artificial Ear & Mouth) 

4-wire Balanced Depends on specific equipment in use 

 Type A 

2 x 3.5mm male jack to  
1 x 3.5mm male jack 

Type B 

RJ-22 plug to 
3.5mm female jack 

Type C 

4 x 4mm plug to 
2 x 3.5mm male jack 

Type D 

4mm plug to 
4mm plug jumper 
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Handset Port 
A connection at microphone level to the handset port of any telephone (POTS, ISDN, IP, etc) 
or to the handsfree port of a cellphone can be achieved directly from the DSLA balanced 
output.  However, the Playlist will require a signal of perhaps –50dBm mean active speech 
level to avoid clipping the microphone input stage of the equipment under test. This is not 
sufficiently above the noise floor of the DSLA and will mean that some impairment exists in 
the source signal. 

The impedance of the DSLA balanced output is 600 ohms. Typically, the microphone will 
have a lower impedance and therefore the DSLA will be mismatched to the microphone input 
stage of the telephone or cellphone. 

Finally, an electret microphone has a bias voltage which is applied to the DSLA output if the 
DSLA is connected to a microphone amplifier. Problems can arise from power supply leakage 
currents and inappropriate earthing. 

The DSLA Handset Port is an RJ22 connector. The connections are presented as shown in the 
diagram below 

1 2 3 4  

Using the Handset Port 
Remove the coiled lead from the telephone handset and connect it to the Handset port. A cell 
phone or other device will require an appropriate adapter to connect to the hands free port or 
the soundcard etc. 

The call must be established, possibly using the telephone’s keypad. Set the DSLA monitor to 
input on each channel so that call progress tones and messages can be heard on the monitor 
loudspeaker or headphones. Alternatively, the call can be established automatically from the 
POTS line on the other channel of DSLA if that is to be the termination or it may be possible 
to establish the call using an appropriate executable program called from a Playlist to control 
the network under test. 

Once the call has been established, Playlists that have been developed for telephone circuit 
tests can be used directly with the handset port without any change to speech levels.  In some 
equipment, the handset port is the only way to establish a four-wire connection that can be 
used for the measurement of echo and other parameters. 

The Quickstart schedules and playlists provide a number of useful examples of measurements 
of speech levels and speech quality between the Handset ports and other network 
terminations. 

The user should recognise that the microphone input stage of the telephone base unit or 
cellphone should have an input impedance greater than 1Kohms and the gain to the network 
junction should be no more than 30dB.  

Pin Description 
1 Output – 
2 Input - 
3 Input + 
4 Output + 
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Using Quick Start Examples 
The Quick Start examples are easily started by selecting an item from the ‘Help|Quick Start 
Examples’ menu.  The Quick Start examples are designed to give DSLA users an insight in 
using DSLA.  For most users, the Quick Start examples should only need a little editing to 
achieve first time results.  However due to the varied nature of the DSLA test environments, 
you may need to make some changes to best suit your needs. 

Schedules and playlists are provided to establish and verify a connection, measure speech 
quality at different levels and to measure speech quality at a fixed level with a range of speech 
material for male and female talkers. 

Before You Begin 
 If this is your first time using the DSLA, you might like to familiarise yourself 

with some of the DSLA’s basic concepts, such as Playlists and using the 
Scheduler. 

 Many of the Quick Start examples use the ASTS files, so you must ensure that 
you have copied your ASTS files to the DSLA before use.  See ‘Copying 
Sound Files to DSLA’ for more information. 

 Sound Files on your hard disk in the Phonytalk folder (Local Files) can be 
used within a Playlist, as can files that have been downloaded to DSLA 
memory. 

 Make sure that you have correctly connected the DSLA hardware to your test 
environment. 

 If you are using a Quick Start example that uses a PSTN dial-up connection, 
then you may also need to edit the dialling string within the relevant ‘Call 
Setup’ Playlist to dial your required number.  Remember to save the Playlist 
afterwards before using the schedule. 



 12 

Channel Window 
Menu: View|Channel (A/B) 

 

 
 
Using the Channel window(s) you can: 

 Start and stop measurements. 

 View Speech Level, Voltmeter and Apparent Power measurements. 

 Open, create, edit and save Playlist scripts. 

 Configure DSLA channel settings such as input impedance etc. 

 

Using the Channel window 
If you need to do more with the DSLA than just simple speech level measurements, you will 
need to either open or create a Playlist script.   

A Playlist consists of a series of events that define what the DSLA is to output (or play), to 
control measurement progress, and control various other DSLA functions.  A Playlist has two 
tracks, on which events can be added.  The Playlist events are interpreted by the DSLA when 
a channel is started. 

To start a measurement 
1. Open the Channel window(s) you wish to start a measurement on. 

2. On the Channel window toolbar, click Start  to start the measurement on that channel. 

To stop a measurement 
1. On the Channel window toolbar, click Stop  to stop the measurement on that channel. 
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To create a Playlist 
1. On the View menu, select either Channel A or Channel B. 

2. Click the Track tab to select the required track you want to add events to. 

3. Do one of the following: 

• To add an event to a Playlist, click the required Event icon. 
(See: Playlist Events) 

• To delete an event from a Playlist, click the event to be deleted, and then click Delete 
 

• To edit an event, double-click the event you wish to edit, or click the event and then 
click Properties  

Notes 
• To add an event to the end of a track, click the blank space following the last event, 

so that the event pointer [‘>’ symbol] points to an empty step. 

• To add an event in the middle of a Playlist, click the step where you wish to insert an 
event, and then click the required event icon on the Channel toolbar. 

To insert an existing Playlist 
You may wish to insert smaller, predefined Playlist sequences into the current Playlist to save 
you recreating the same sequences over again.  An existing Playlist can be inserted anywhere 
within the current Playlist, or appended to the end of the current Playlist. 

1. Click the Playlist step where you wish to insert an existing Playlist. 

2. Right-click in the Playlist window and select Insert Playlist from the context menu. 

3. In the ‘Look in’ box, click the drive or folder that contains the Playlist. 

4. In the folder list, double-click folders until you open the folder that contains the Playlist 
you want. 

5. Double-click the Playlist you want to open. 

Note 
• When inserting a Playlist within a Playlist which contains Repeat or PAMS events, 

take care to make sure the events, ‘Start From Step’ property is still valid. 

To save a Playlist 
1. Click Save Playlist  on the Channel window that contains the Playlist you want to save. 

2. Select the format to save the Playlist file as using the File Type drop-down list box. 

3. In the File name box, type a name for the Playlist. 

4. Click Save. 
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Viewing the Results 
The measurement results are displayed in the right hand side of the channel window.  There 
are three selectable result displays: 

Speech Duration: Shows the measurement period so far in seconds. 

 Longterm: Shows the average level of the input signal in the 
selected measurement unit over the entire measurement 
period. This is a true RMS reading. 

 Active: This is the mean active speech level in the selected 
measurement unit. The active level result is repeatable for 5 
seconds or more of speech. 

 Activity: This is the activity factor expressed as a percentage 
of the total time where the mean active speech level is 
exceeded, i.e. speech is present. 

 Peak: This is the highest instantaneous level in the selected 
measurement unit. 

  

Voltmeter Displays level in current measurement units. 

Apparent Power Displays apparent power in current measurement units. 

Additional Results 
A delay figure, expressed in milliseconds, is displayed in the channel status bar.  (Only when 
a Delay Event is used within a Playlist).  Delay of signal is accurately expressed within 3ms 
for a sine wave or within 5ms for speech, provided the speech signal on both channels is 
active when the measurement is stopped. 

The Dual Activity result is displayed at the bottom of the DSLA window when measurements 
are made on both channels simultaneously. 

Setting channel properties 
The current channel settings are displayed in the right-hand side of the status bar.  Clicking on 
the setting will toggle through the available options. 

The available settings are: 

Input Impedance: 600, High, Complex 

Input Selection: Balanced, Phone Line, Handset  

Filter: Off, On  (200Hz-5kHz bandpass filter) 

Measurement Units: dBm, dBv, dBr and mV 



 15

Playlist Synchronisation 
There are a maximum of four tracks of Playlist sequences (two per channel). However, the 
initiation / execution of any Playlist item is performed sequentially (one at a time) and 
different Playlist commands take varying amount of time to execute. For example, the Start 
Measurement command takes around 2ms to execute and will therefore introduce this amount 
of delay between measurements on both channels. 

Where it is necessary for Playlists to be in synchronisation (especially when starting a 
measurement) it is recommended that one Playlist issue a ‘Sync On’ command and the other 
Playlist(s) wait until the former is ready by containing a’ Wait For Sync’ command. It may be 
necessary to experiment to determine which Playlist should issue 'Sync On'. 



 16 

Playlist Events 

Speech 
Plays back a sound file at any defined mean active speech level. 

Icon  

Parameters 

File File to playback.  Can be either a DSLA memory resident file, 
or a local file (Ethernet option only) 

Output Level Specifies the output level of the file in the units at the time 
the event is created. 

DTMF 
Generates the DTMF tones 0-9 ABCD #*.   

Icon  

Parameters 

DTMF Sequence Specifies the DTMF sequence to generate. 

Dial Outside Line Prefixes the DTMF sequence with the specified number you 
use to access an outside line. 

Duration Specifies the duration of each DTMF digit. 

Output Level Specifies the output level of the DTMF digits in the current 
units. 

Remarks 

• Use the ‘,’ (comma) character in the DTMF sequence to insert a 2 second pause. 

• DTMF Analysis Option users can specify advanced DTMF parameters, such as inter-
digit duration by clicking the Advanced button and selecting the Enable Advanced 
Options check box. 

Noise 
Generates ‘White’ noise. 

Icon  

Parameters 

Duration Specifies the duration of the noise signal. 

Output Level Specifies the output level of the DTMF digits in the current 
units. 
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Sinewave 
Generates either a fixed frequency Sinewave from 10–15kHz, or a swept Sinewave at any 
defined level. 

Icon  

Parameters 

Use Fixed Frequency Specifies the fixed frequency in Hz. 

From / To Frequency Specifies the swept frequency in Hz. 

Duration Specifies the duration of the Sinewave. 

Output Level Specifies the output level of the Sinewave in the current 
units. 

Repeat 
Repeats a group of Playlist events. 

Icon   

Parameters 

From Step Specifies the event step from which you wish to start the 
repeat group from. 

Repeat Specifies the number of times to repeat. 

Example 

The following example starts a measurement on Channel A, and then repeats two speech 
phrases 10 times. 

Step Type Description 

1  Start Measurement [A] - Repeat Example 
2  Speech 1 
3  Speech 2 
4  Step = 2, Repeat = 10 

Continue Measurement 
Re-starts a mean active speech level measurements without resetting the previously 
accumulated results. 

Icon  
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Delay - Active Level 
Calculates network delay using the Active Level method. 

Icon  

Remarks 

• This event must be used after a ‘Start Measurement [BOTH] event. 

• Recommended for tone signals and compressed speech.  

• The signal delay is accurately expressed within 3ms for a sine wave or within 5ms for 
speech, provided the speech signal on both channels is active when the measurement 
is stopped. 

Example: 

Channel A Track 1 

Step Type Description 

1  Start Measurement [BOTH] 
2  Wait [00:00:01:00] 
3  Delay - Active Level 
4  Stop Measurement [BOTH] 
 

Channel A Track 2 

Step Type Description 

1  Speech file 1 
2  Speech file 2 
 

The signal sent on Channel A should be received by Channel B. The Wait duration should be 
set to ensure that the delayed speech received by Channel B is active when the measurement 
stops.   
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Delay - End-End-End 
Calculates network end-end-end delay. 

Icon  

Parameters 

Start Measurement from Step Specifies the event step from which the measurement 
begins. 

Remarks 

• This delay measurement differs from round-trip delay in that ITU-T G.107 specifies 
RTD within network junctions.  This is a true measurement from one end point to 
another. 

Example: 

The following example sets Channel A to start a measurement and play the deluttfem.wav 
speech phrase.  Channel A then waits for the deluttm.wav speech phrase played from Channel 
B and finally calculates the End-End-End delay. 

Channel B is set to wait until the deluttfem.wav speech phrase played from Channel A is 
detected and then plays the deluttm.wav speech phrase.   

Channel A 

Step Type Description 

1  Start Measurement [A] – E3 Example 
2  deluttfem.wav @ -20dBm 
3  Wait - Speech [deluttm.wav] 
4  Delay [End-End-End] – from step [ 2 ] 
 

Channel B 

Step Type Description 

1  Wait – Speech [deluttfem.wav] 
2  deluttm.wav @ -20dBm 
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Delay - Time Align 
Calculates delay between the reference and delayed signals using the Time Alignment method 
in the DSLA. 

Icon  

Parameters 

Ref Channel Specifies the reference channel (A / B). 

Ref Input, Output Specifies whether the reference data is present at the input 
or output of the reference channel. 

Dly Channel Specifies the delayed signal input channel. 

Remarks 

• This event makes allowance for the delay inherent in the DSLA and so may differ in 
result from the average time offset displayed in the Speech Quality Analysis results 
window. 

Example 

The following example starts a measurement on Channel A and initiates a delay measurement 
on the signal received by Channel A using the Time Align method. 

 

Channel A Track 1 

Step Type Description 

1  Start Measurement [A] – Delay [TA] Example 
3  Speech file 1 
4  Speech file 2 
5  Stop Measurement [A] 
 

Channel A Track 2 

Step Type Description 

1  Delay –TA [Ref Chan  :A ,OUT Delay Chan  :A] 

DTMF Analysis (available only if DTMF Analysis option installed) 
Analyses received DTMF tones. 

Icon  

Parameters 

Expected Sequence Specifies the expected DTMF digits. 

Record from Channel Specifies the receive channel for the DTMF tones. 
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Execute Application 
Executes an external application. 

Icon  

Parameters 

File Path Full file path to the application to be executed. 

Description Description to identify this event. 

Wait for Process If enabled, the DSLA application will wait until the external 
application terminates. 

Remarks 

• This event must be used in conjunction with a ‘Start Measurement’ event. 

• This event can be placed anywhere within a Playlist, but the specified application will 
only be executed after all other events on both channels have stopped. 

Gain 
Allows the input level to be amplified or attenuated after the A/D converter. 

Icon  

Parameters 

Gain Specifies the amount of gain/attenuation to be applied to the 
input signal in dB. 

Remarks 

• 40dB maximum gain is available. 

• You must reset the gain to 0dB after using this event. 

Phone Off-Hook 
Sets the DSLA phone interface to off-hook state. 

Icon  

Remarks 

It is important to wait a second for the line card to respond and the DSLA phone circuit to be 
powered after going off-hook.  
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Phone On-Hook 
Sets the DSLA phone interface to on-hook state. 

Icon  

Silence 
Inserts a silence period between ‘Speech’ events when using a ‘Speech Quality Analysis’ 
event. 

Icon  

Parameter 

Duration Specifies the silence duration. 

Remarks 

• This event is not the same as using a ‘Wait’ event. 

Start Measurement 
Starts mean active speech level measurements on the selected channel(s).   

Icon  

Parameters 

Caption [Optional] Description used to identify this result set. 

Starts Specifies on which channel(s) to start a measurement. 

Remarks 

• You must use this event if you want your results logged to a results file, or included in 
the Results Manager for later analysis. 

Stop Measurement 
Stops mean active speech level measurements on the selected channel(s). 

Icon  

Parameters 

Stops Specifies on which channel(s) to stop a measurement 
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Speech Quality Analysis 
Executes a speech quality analysis test. 

Icon  

Parameters 

Start Measurement from Step Specifies the event step from where the reference 
measurement data starts. 

Record from Channel Specifies the receive channel for the degraded data source. 

Remarks 

• This event must be used in conjunction with a ‘Start Measurement’ and at least 4 
seconds of ‘Speech’ events. 

• A measurement must have been started on the channel that the ‘Record from Channel’ 
parameter has been set to. 

Example 

The following example starts a measurement on Channel A, plays three speech files and 
executes a speech quality analysis test using the Channel A input. 

Step Type Description 

1  Start Measurement [A] - PAMS Example 
2  Speech file 1 
3  Speech file 2 
4  Speech file … 
5  Wait [00:00:01:00] 
6  PAMS from Step 2, REC = A 
Step 5 is important to allow sufficient time for the speech signal to traverse the network.. 

Sync 
Continues Playlist execution after a ‘Wait for Sync’ event has been executed. 

Icon  

Parameters 

Sync Status On / Off 

Remarks 

• The Sync status must be set ‘Off’ before another ‘Wait for Sync’ event is used. 
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Wait 
Waits for the specified duration. 

Icon  

Parameters 

Duration Specifies the duration to wait before Playlist execution 
continues. 

Wait - Active Level 
Waits until the specified Active Level has been reached for the given minimum period. 

Icon  

Parameter 

Active Level Specifies the mean active speech level to detect 

Minimum Period Specifies the minimum period to detect the specified mean 
active speech level before Playlist execution continues. 

Wait - Channel 
Waits until the specified channel and track are not waiting. 

Icon  

Parameters 

Channel A, B 

Track 1, 2 

Wait - DTMF 
Waits until the specified DTMF sequence has been detected. 

Icon  

Parameters 

DTMF Sequence Specifies the DTMF sequence to detect before Playlist 
execution continues. 
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Wait - Ring Detect 
Waits until the specified number of ring signals have been detected. 

Icon  

Parameters 

Ring Specifies the number of times the ring signal should be 
detected before Playlist execution continues. 

Note that the ringing voltage must exceed 18Vrms. 

 

Wait - Speech 
Waits until the specified speech file has been detected. 

Icon  

Parameters 

Speech File Specifies the speech file to detect before Playlist execution 
continues. 

Wait - Sync 
Waits until a ‘Sync = On’ event is executed. 

Icon  

Wait - Tone 
Waits until the specified tone has been detected. 

Icon  

Parameters 

Frequency Specifies the frequency of the tone to detect in Hz. 

Tolerance Specifies the tolerance of the Frequency parameter in Hz. 

Tone Duration Specifies the minimum duration of the tone to be detected in 
mS. 

Wait Until Tone Stops By default, Playlist execution continues after the tone has 
been detected.  If this option is enabled, Playlist execution 
will continue once the detected tone stops. 
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DSLA Explorer 
Menu: Tools|DSLA Explorer 

 

 
 
Using the DSLA Explorer, you can: 

 Create and delete folders to organise sound files within DSLA memory. 

 Delete old or unused sound files from DSLA memory. 

 Copy new sound files from your PC to DSLA. 

 Save sound files from DSLA to your PC in a variety of file formats. 

 Save the contents of the DSLA record buffers. 

 Preview sound files within DSLA memory. 

Using DSLA Explorer 

To create a new folder 
1. Open the DSLA Explorer window (Tools|DSLA Explorer). 

2. In the folder view, select where you want to create a new folder. 

3. On the DSLA Explorer toolbar, click Create New Folder  
The new folder appears with a temporary name. 

4. Type a name for the new folder, and then press ENTER. 
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To rename a file or folder 
1. Open the DSLA Explorer window (Tools|DSLA Explorer). 

2. Click the file or folder you want to rename.  

3. Press F2. 

4. Type the new name, and press ENTER. 

To delete a file or folder 
1. Open the DSLA Explorer window (Tools|DSLA Explorer). 

2. Click the file or folder you want to delete. 

3. On the DSLA Explorer toolbar, click Delete  

To refresh DSLA Explorer 
1. Press F5 to refresh the DSLA Explorer window if you have added files to the Phonytalk 

folder. 

Copying sound files to DSLA 
Before you can use the DSLA to playback sound files, such as WAV files or ASTS files, they 
must first be copied to DSLA memory.  You can either copy individual files, or you can 
choose to copy a folder containing your files to DSLA. 

Copying a folder can be useful when you want to use your sound files as the source for speech 
quality testing, as your sound files must exist within the same DSLA folder hierarchy as they 
appear on the PC in order that the speech quality metric can access them. 

Ethernet equipped DSLA’s can also replay sound files directly from the PC hard disk. 

To copy sound files to DSLA 
1. Open the DSLA Explorer window (Tools|DSLA Explorer). 

2. Select or create the folder where you wish to copy the sound file(s).  

3. Do one of the following: 

• To copy individual sound files to the DSLA, click Send Sound File   Using the 
Open dialog box, select the file(s) you wish to send to the DSLA, and click Open. 

• To copy a folder and all its sub-folders to the DSLA, click Send Folder Structure   
Using the Browse for Folder dialog box, select the folder you wish to copy, and click 
OK. 
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Saving sound files to your PC 
You can save sound files stored in DSLA memory to your PC (except for ASTS files).  Sound 
files can be saved in the following formats: 

 Windows Wave PCM, 8/16k, 16 bit, mono 

 A/mu-Law Wave 8k, 16 bit, mono 

 A/mu-Law Raw 8k, 16 bit, mono 

 PCM Raw 8k, 16 bit, mono 

To save sound files to your PC 
1. Open the DSLA Explorer window (Tools|DSLA Explorer). 

2. Click the sound file you want to save to disk. 

3. On the DSLA Explorer toolbar, click Save Sound File  

4. Using the Save dialog box, select the folder where you wish to save the file. 

5. Select the format to save the sound file as using the Save as type drop-down list box. 

6. Click Save. 
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DSLA Scheduler 
Menu: Tools|Scheduler 
 

 
 
Using the DSLA Scheduler, you can: 

 Automate execution of DSLA Playlist scripts. 

 Execute a test set repeatedly, or a specified number of times. 

The DSLA Scheduler is ideal for use where a number of different tests and/or setup routines 
are required.  A Schedule consists of a sequence of tasks which are used to define individual 
test setups. 

Using DSLA Scheduler 

To create a schedule 
1. Open the Scheduler window (Tools|Scheduler). 

2. Do one of the following: 

• To add a new task, click Add Task  
Configure the task as required using the ‘Task Properties’ dialog box. 

• To insert a task, right-click on the task where you wish to make an insertion and select 
‘Insert’ from the context menu. 

• To edit a task, double click the task you wish to edit. 

• To delete a task, select the task you wish to delete and click Delete Task  

3. Repeat Step 2 until you have added all the required steps for this schedule. 

4. Click Scheduler Properties  
Configure the Scheduler using the Scheduler Properties dialog box. 
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To open a schedule 
1. Open the Scheduler window (Tools|Scheduler). 

2. Click Open Schedule  

3. Navigate to the folder that contains the schedule file. 

4. Double-click the Schedule you want to open. 

Note 
• Schedule files can also by opened by selecting the appropriate Schedule file name 

displayed in the Help|Quick Start menus. 

To save a schedule 
1. Click Save Schedule  

2. In the File name box, type a name for the Schedule. 

3. Click Save. 

To delete a schedule task 
1. Click the task to be deleted. 

2. Click Delete Task  

To start a schedule 
1. Open the Scheduler window (Tools|Scheduler). 

2. Do one of the following: 

• To open an existing schedule file, click Open Schedule  

• Create a new Schedule. 

3. Click the task from which you wish playback to start. 

4. Click Start Schedule  

To stop a schedule 
1. Click Stop Schedule  
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Scheduler Properties 

 
The Scheduler Properties dialog box is used to configure the current schedule’s operation.   

Auto-Loop 
This section specifies what happens when the last task in task list has finished executing.  The 
Scheduler can be set to either end after the last task, or, restart from any task within the task 
list.  If the Scheduler is set to re-start, you can specify the period at which the re-start occurs, 
and how many times the re-start should occur before stopping. 

Restart Schedule from Task Specifies the task at which the Scheduler will restart.  If 
this property is set to *DISABLED* the Scheduler will 
stop after the last task has finished executing. 

Immediately after last task Specifies that the restart starts immediately after the last 
task has finished executing. 

Every X minutes Value specifying the number of minutes the Scheduler 
should wait before the restart occurs. 

Daily Value (HH:MM:SS) specifying the time at which the 
restart should occur. 

Continuously Specifies that the Scheduler should continue restarting 
until ‘Stop Schedule’  is clicked. 

Execute X times Value specifying the number of times the Scheduler 
should restart. 
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Results Logging 
This section allows you to specify where ASCII test results are written.  You can choose 
either the default results log file as specified in Tools|Options|Results Manager|Results Log, 
or specify another file path. 

Use my default results log file Uses the results log file specified in 
Tools|Options|Results Manager|Speech Measurements. 

Use this file path to log my results Uses the file path specified in the file path text box.  If 
this file does not exist it is created. 

 

Columns 
This section allows you to select which columns are displayed in the Scheduler task list.  

To change the columns displayed in the Scheduler task list 
1. To add a column, click the check box next to the column name. 

2. To remove a column, clear the check box next to the column name. 

3. To restore the default view, click ‘Restore’. 
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Scheduler Task Properties 

 
The Task Properties dialog box is used to configure how a task executes.  It is divided into 
several option pages as described below: 

Task options 
This section is used to configure the general task settings. 

Task Description Description used to identify this task in the Scheduler task 
list. 

Channel A/B Playlist Specifies the Playlists to load into Channel A/B.  Use the 
Browse buttons, or enter the full file path to an existing 
Playlist. 

Execute Value specifying how many times this task will execute.  A 
setting of 0 will disable the task. 

Write Task Description field 
to results log 

Appends the Task Description field to the results log. 
Useful for identifying particular tasks in the results log file. 

Task|Start Time 
This section specifies when the task should begin executing. 

Run this task immediately  Specifies that this task executes immediately after the last 
task has finished executing. 

Every X minutes Value specifying  the number of minutes the Scheduler 
should wait before this task executes. 

Daily Value (HH:MM:SS) specifying the time at which this task 
will start. 



 34 

Task|Time Out 
Using the default settings, the Scheduler will wait indefinitely for each task to complete.  
However, some test scenarios may benefit from allowing the Scheduler to execute another 
task if the current task may not complete execution – i.e.  when waiting for an exchange to 
answer a call. 

Timeout Sets the timeout period for this task.   

Next Task Specifies the task that executes after the timeout period has 
expired. 

Task|Next Task 
Using the default settings, the Scheduler will step through tasks sequentially.  Some test 
scenarios may require more control over the task sequencing options, such as creating inter-
schedule loops, or out of sequence jumps. 

Next Task Specifies the next task to execute.   

Execute Value specifying the number of times the ‘Next Task’ setting is 
executed.  Once this value is exceeded, the default behaviour applies. 

Channel Properties 
This section configures the channel setup properties.  The settings specified here override the 
current channel settings.  The next task to be added to the Schedule will inherit the previously 
specified settings, so there is not normally any need to keep specifying these settings. 

Input Impedance 600, High,Complex  

Input Selection Balanced, Phone Line, Handset 

Filter On, Off  (200Hz-5kHz bandpass filter) 

Tone Burst Tone Burst mode 

Sample Rate Use Current Setting, 8000, 16000 

Speech Quality Analysis 
This section allows you to override the default speech quality metric processing options as 
specified in Tools|Options|Speech Quality Analysis. 

Results Analysis 
This section allows you process the last group of results since the last analysis was executed.  
You may also choose to save the analysis results to the specified ASCII formatted file. 
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Results Analysis|Conditional Actions 
If you have chosen the Results Analysis option, you can specify a conditional expression, 
which when evaluated is true, will execute the following selected actions 

Retry from Task Select this action to specify which task will execute next. 

Send E-Mail To Select this action to have an alert E-mail sent to the specified 
address. 

Equalisation 
This section allows you to specify a filter preset that will be applied to any sound files played 
by DSLA.  If your Playlist uses DSLA memory resident sound files, the required pre-
equalized sound files must exist in DSLA memory.  If your Playlist is using local files, the 
selected filter will be applied to the source sound files before it is streamed to DSLA. 

See DSLA Equaliser for more information on using equalised sound files. 
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Results Manager 
Menu: Tools|Results Manager 
 

 
 
Using Results Manager, you can: 

 Open, save, delete and view result sets. 

Using Results Manager 
A result set is added to the Results Manager history window after a measurement has been 
generated using: 

• a Playlist Start Measurement event.  

• the Manual Input section on the PAMS/PESQ window. 

• the Speech Quality Batch Processor. 

Selecting a result set displayed in the Results Manager history window will display the results 
data in all the relevant open display windows. 

To open a results set (*.rst file) 
1. Open the Results Manager window (Tools|Results Manager). 

2. On the Results Manager toolbar, click Open  

3. Navigate to the folder where the file is located. 

4. Select the results file(s) that you want to open, and then click Open. 

To view results set properties 
1. Open the Results Manager window (Tools|Results Manager). 

2. On the Results Manager toolbar, click Properties  
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To delete a results set 
1. Open the Results Manager window (Tools|Results Manager). 

2. Click the results set you wish to delete. 

3. On the Results Manager toolbar, click Delete  

Note 
• Deleting a result set, only removes the results set from the Results Manager history 

window, it does not delete result sets saved to disk. 

To view the results log file 
1. Open the Results Manager window (Tools|Results Manager). 

2. On the Results Manager toolbar, click View Results Log  

Saving Results 
After a measurement has been generated, the results data can be saved automatically to a tab 
delimited ASCII format file and/or a results (*.rst) file.  You are also able to save individual 
result sets manually, in either format, via the Results Manager window. 

The measurement parameters that are written to the ASCII file are user definable, but 
graphical data is not saved.  A results (*.rst) file contains all the numerical and graphical data 
and can be opened and viewed later using Results Manager or the Speech Performance 
Viewer available from our website. 

Result limits (Tools|Options|Results Manager|Speech Measurements|Limits) can be defined 
for various measurement parameters so that only those results that exceed the specified limits 
are saved. 

Note: 
• All unsaved results are lost when the DSLA application is closed. 

To automatically save results to an ASCII format file 
1. On the Tools menu, click Options. 

2. Select the Results Manager|Speech Measurements options page. 

3. Check the Write results to an ASCII log file option box.  

4. If you only want to save results that exceed your defined measurement limits, check the 
Only log results that exceed limits option box. 

5. In the File Path textbox, type the full path to the results log file. 

6. In the Results Log Fields list box, check the measurement parameters you want written 
to the log file. 

7. Click OK. 



 38 

To automatically save results to a results (*.rst) file: 
1. On the Tools menu, click Options. 

2. Select the Results Manager options page. 

3. Check the Auto-save result files option box. 

4. If you only want to save results that exceed your defined measurement limits, check the 
Only save results that exceed limits option box. 

5. Click OK. 

To manually save results to a log (ASCII) or results (*.rst) file 
1. Open the Results Manager window (Tools|Results Manager). 

2. Click the results set you wish to save.  

• To select multiple result sets at the same time, use Ctrl+Click. 

3. On the Results Manager toolbar, click Save Results  

4. Navigate to the folder where you want to save the file. 

5. Select the format to save the results file as using the File Type drop-down list box. 

6. Type a name for the result set in the File Name text box. 

7. Click Save. 

Specifying Result Limits 
By default, Results Manager will save all results set data when configured to log or auto-save 
results.  However, if you are only interested in results data that you consider to have failed a 
test condition, then this can lead to large amounts of unwanted data.  By specifying result 
limits, Results Manager will only log or save results sets that fall outside those limits. 

To specify result limits 
1. On the Tools menu, click Options. 

2. Select the Results Manager|Speech Measurements|Limits options page. 

3. Type a value in the Limits section for any measurement parameter that you want to 
specify a limit for. 

4. Click OK. 
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Results Analyser 
Menu: Tools|Results Manager 
 

 
 
Using the Results Analyser you can: 

 Easily view result statistics in both numerical and graphical formats. 

 Save result analysis data to an ASCII format file. 

Analysing your results using Results Manager 
1. Open the Results Manager window (Tools|Results Manager). 

2. Select the group of results you want analyse. 

3. Click Results Analyser  

 

Analysing your results using DSLA Scheduler 
1. Open or create a new Schedule. 

2. Select a task and click Edit Task  

3. Select the Results Analysis options page. 

4. Check the Analyse Results option box. 
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Thresholds 
Menu: View|Thresholds 
 

 
 
The ITU. Rec. P.56 speech measurement algorithm implemented in the DSLA involves 
comparing and accumulating the input signal to an array of 17 fixed thresholds.  These 
thresholds are referred to as the Activity Count Array.   

The result of these comparisons is displayed as histograms for each channel and allows you to 
see how the signal energy has been distributed during the measurement period.   

Typically there will be two peaks in the signal distribution, one will be the residual or noise, 
and the other will be the speech activity. 
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Speech Level Controller 
Menu: Tools|Speech Level Controller 
 

 
 
Using the Speech Level Controller, you can: 

 Configure the DSLA to output a constant mean active speech level for a given 
variable input level.  The input material is output on the desired channel at the 
level specified. 

Using the Speech Level Controller 
1. Connect the input signal to the desired input connection. 

2. Connect the receiving equipment to the desired output connection. 

3. Set the parameters on the Speech Level Controller dialog box to the required settings. 

4. Click Active. 

Note 
• You cannot run a Playlist on the same channel as the ‘Output Channel’ selection, 

whilst speech level control is active. 
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Monitor Levels 
Menu: Tools|Monitor Levels 
 

 
 
Using the Monitor Levels window, you can: 

 Set the output gain and channel source for the monitor output on the front 
panel of the DSLA hardware. 

To change the monitor levels 
1. Click the channel indication label to toggle between Channel A and B. 

2. Click the In/Out LED option button(s) to enable/disable monitoring for the In/Out section 
on each channel. 

3. Adjust the slider(s) to set the monitor level. 

Note 
• It’s usually best to monitor the inputs on Channel A and B only, as monitoring the 

outputs as well can lead to confusion. 
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Speech Quality Batch Processor 
Menu: Tools|Speech Quality Batch Processor 
 

 
 
Using the Speech Quality Batch Processor, you can: 

 Analyse speech quality of a large number of sound files without user 
intervention. 

 Generate an ASCII formatted file containing the scores which can then be 
imported into a spreadsheet as a tab-delimited text file for further analysis. 

Using the Speech Quality Batch Processor 
1. Open the Speech Quality Batch Processor window (Tools|Speech Quality Batch 

Processor). 

2. Do one of the following: 

• To create a new profile, type a profile name in the Profile Name list box. 

• To use a previous profile, select a profile name from the drop down list. 

3. Click Next. 

4. Specify the reference and degraded file paths to process into the reference and degraded 
file path text boxes.  (See: Specifying files for processing) 

5. Type a wildcard string into the Wildcard text box to match your reference and degraded 
files.  (See: Setting the wildcard string) 

6. Click Next. 
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7. Verify the matched files displayed in the Matched File Preview: 

• Click Back if you need to revise your file matching specifications. 

• Use Ctrl+Click to select any files in the Matched File Preview display that you do not 
want to process, and then press Delete. 

• Click Next when the Matched File Preview correctly displays the files you want to 
process. 

8. Type the file path to the results log file. 

9. Click Next. 

10. To view or change the options used by the Batch Processor to process your files, click 
Options. 

11. Click Next to begin processing your files. 

Specifying files for processing 
The reference and degraded file paths must include either a filename, or a wildcard as part of 
the file path. 

Examples of file paths 

c:\myfolder\myfile.wav Use the file, ‘myfile.wav’ in the folder, ‘c:\myfolder’. 

c:\myfolder\* Use all the files within the folder, ‘c:\myfolder’. 

c:\myfolder\???.wav Use any file that has a three character filename followed by a 
.wav extension. 

Setting the wildcard string 
Because of the various methods used for naming files, a wildcard string is used to find a 
match between the reference and degraded file names.  Therefore, the wildcard string used is 
dependent on the logic behind your file naming convention.   

The general rules to follow when entering wildcard strings are as follows:   

 Use the ‘?’ character where a matching character in both filenames must be 
present. 

 Use the ‘*’ character to ignore miss-matching filename characters. 

 Use [text] to search for the string text within the degraded filename.  The 
search text is not matched against the reference file. 

 Use [N] where N is a number of characters to skip within the degraded 
filename. 
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Examples of file matching wildcards    

Reference Degraded Wildcard Match 

Cb.wav AN0_Cb.pcm [_]??* True 

Cb.wav AN0_Cb.pcm [_]??.wav False 

Cb.wav AN0_Ft.pcm [_]??* False 

F00p01.17r F00p01.12d ?00p??* True 

F00p01.17r F00p02.12d ?00p??* False 

M00p01.17r M00p01.13d ?00p??* True 

M00p01.17r F00p01.12d ?00p??* False 

abfile.pcm rec_abfile_deg [4]??* True 

abfile.pcm rec_abfile_deg [rec_]??* True 

abfile.pcm rec_cdfile_deg [rec_]??* False 
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DSLA Equaliser 
Menu: Tools|Equaliser 
 

 
 
Using the DSLA Equaliser you can: 

 Create filter characteristics that can then be applied to your sound files. 

Introduction 
Parts of the telephone network expect speech signals to lie within particular bandwidths or to 
have some spectral characteristic. For example, applying a wideband speech signal with 
significant energy above 4kHz directly into a network may cause impairments because the 
network equipment expects a signal rolled off above 3.8kHz.    

Using the DSLA Equaliser, you can apply any desired filter characteristic to 8 or 16k sample 
rate sound files.  You can create your own filter characteristics for your particular application, 
or use one of the following supplied filter characteristics: 

• A typical Brüel & Kjær Head and Torso Simulator (HATS) artificial mouth 
characteristic. 

• Intermediate Reference System Send (IRS). 

• Modified Intermediate Reference System Send (mIRS)(ITU-T Rec. P.830). 

• Low and High pass filters. 

Filter presets created with the DSLA Equaliser can be used in conjunction with the Scheduler 
to enable reference speech to be filtered for playback via DSLA, but the original reference 
speech is still used for Speech Quality Analysis. This feature is useful for the HATS 
application where wideband speech is equalised for the artificial mouth characteristic but you 
need to compare the degraded speech with the original wideband reference material. 
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DSLA and Equalisation in the HATS application 
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Using the DSLA Equaliser 

To create or modify a filter preset 
1. Open the DSLA Equaliser window (Tools|Equaliser). 

2. Do one of the following: 

• To create a new filter preset, click New Filter  

• To modify an existing filter preset, select the desired filter from the Presets drop-
down listbox. 

3. Double-click to insert a node at the current frequency and gain point. 

4. Right-click an existing node to specify the exact frequency and gain, or to remove the 
node. 

5. Click and drag an existing node to move the node to a new frequency/gain point. 

Note 

• To modify a protected filter preset, you must first right-click within the drawing area 
and de-select the Protected menu option. 
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To save a filter preset 
1. Click Save  

2. Type a name for your profile in the Save Filter Profile dialog box. 

3. Click the Protected check box if you want to protect your profile from begin accidentally 
changed in the editor. 

4. Click Save. 

To delete a filter preset 
1. Select the filter preset you want to delete from the drop-down listbox. 

2. If the preset has been protected, right-click within the drawing area and de-select the 
Protected menu option. 

3. Click Delete Filter  

Applying a filter preset to your sound files 
1. Open the DSLA Equaliser window (Tools|Equaliser). 

2. Click Apply Filter  

3. Follow the steps in the Equalisation Wizard. 
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DTMF Analysis 
Menu: View|DTMF Analysis 
 

 
 
The DTMF Analysis window reports: 

 Received digit status: 
Green (OK), Blue (OK, but on specification limits), Red (Failed) 

 Decoded digits 

 On/Off durations 

 Twist  

 Received high and low frequencies 

 Received levels. 

Analysing DTMF Signals 
Measurements can be made on DTMF signals whether generated by DSLA or received from 
the network.  The DSLA can generate any of the 16 DTMF signals with any duration, inter-
digit silence, twist or frequency shift. 

An analysis is perform on the DTMF digits received by DSLA by including the DTMF 
Analysis control event in your Playlist.  The following Playlist example will output all the 
available DTMF digits and then analyse the received digits on Channel B. 

Step Type Description 

1  Start Measurement [B] – DTMF Analysis Example 

2  DTMF “1234567890#*ABCD” @ -10 dBm 

3  DTMF Analysis [REC=B] 
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Writing DTMF Analysis results to an ASCII log file 
1. On the Tools menu, click Options. 

2. Select the Results Manager|DTMF Measurements options page. 

3. Check the Write Results to an ASCII log file option box. 

4. Click OK. 

Using DTMF result limits 
1. On the Tools menu, click Options. 

2. Select the Results Manager|DTMF Measurements options page. 

3. Type the limits you would like applied into the Limits text boxes. 

4. Click OK. 

 

Operational departures from standard (Bellcore TR-TSY-000181, EIA/TIA-464A, ITU-T Q.24) 
values:- 

Frequency Deviation - All digits detected at ±1.5%, all digits rejected at ±3.5% 

Minimum Tone Duration - All digits detected with 40ms pulse width, all digits rejected with 
23ms pulse width 

Minimum Interdigit Interval - 40ms gap causes two digits to be detected for all digits. 10ms 
gap is bridged and a single digit is detected for all digits. 

Minimum Cycle Time - 93ms 

Accept Levels - Detects all digits in range of +1 to -37dBm. Rejects all digits ≤ -55 dBm. 

Twist (ratio of high group power to low) - Detects all digits for twist of +4 to -8dB 

Noise - All digits detected for noise up to 15dB below tone level 

Echo - Detects all digits with echo more than 10dB below tone level with echo up to 20ms 
delay 
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Miscellaneous 

Upgrading the DSLA's firmware 
The DSLA operating system can be upgraded by sending an .EPR file to the DSLA via either 
a serial connection or an Ethernet connection (firmware version  4.31 or better).  The original 
firmware revision .EPR file that shipped with your DSLA can be found in the DSLA 
installation folder. 

1. Establish a connection to the DSLA. 

2. On the Tools menu, click Options 

3. Select the DSLA|Firmware Update options page. 

4. Click Install. 

5. Using the Open dialog box, navigate to the folder where the .EPR file is located. 

6. Select the .EPR file that you want to use and then click Open. 

Specifying the default user interface language 
By default, the DSLA user interface is displayed using the current operating system regional 
settings.  However, you can override this setting by specifying one of the following supported 
languages: 

 Chinese (Simplified) 

 Chinese (Traditional) 

 English 

 French 

1. On the Tools menu, click Options. 

2. Select the General|International Settings options page. 

3. Select the required user interface language from the drop-down listbox. 

4. Click OK. 

5. Restart the DSLA application. 

Logging and suppressing error messages 
Operational errors generated whilst using DSLA can be suppressed and logged to the file 
<InstallDir>\DSLA\Results\Error.log.  This option is particularly useful when using the 
Scheduler and unattended operation is required. 

1. On the Tools menu, click Options. 

2. Select the General options page. 

3. Check the Log and suppress errors checkbox. 

4. Click OK. 
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Using headerless (raw) sound files 
Headerless (RAW) sound files, can only be used as a source for speech quality analysis - 
either via the ‘Manual Input’ section of the for Speech Quality Analysis display windows, or 
when using the Speech Quality Batch Processor.  

Before using headerless files, you must make sure that you have correctly specified the file 
format that you are using.  Not doing so may give incorrect result measurements.  Currently 
supported sound file formats are: 8/16k sample rates, mono, 16-bit, Intel / Motorola format. 

1. On the Tools menu, click Options. 

2. Select the Speech Quality Metrics|Sound File Data Format options page. 

3. Set the format parameters to match your file type. 

4. Click OK. 

Specifying default folder paths 
You can specify the default folder paths used for speech sets, Playlist scripts, result sets and 
downloaded files. 

1. On the Tools menu, click Options. 

2. Select the General options page. 

3. In the Folder Location box, click the folder you wish to modify. 

4. Click Modify. 

5. In the ‘Browse for Folder’ dialog box, select the folder you want to use as the default for 
the folder location you selected. 

6. Click OK. 

Recording 
Recorded files are viewed using the DSLA Explorer.  They appear in the explorer at the 
DSLA root level.  Playback and manipulation of recorded files is performed in the same 
manner as speech files. 

To start recording 
1. Open the Channel window(s) you wish to use. 

2. On the channel status bar, click REC to enable the record button on the toolbar. 

3. Click the record button on the channel toolbar. 

To stop recording 
1. On the Channel window toolbar, click Stop  
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Items that appear in the status bar 
The status bar, which is the horizontal area at the bottom of the DSLA main window, 
provides information about the current state of the DSLA connection and any other contextual 
information.  

Item Description 

Connection Status Displays the connection status to the DSLA. 

Dual Activity Displays the Dual Activity value. 

Auto On-Hook Normally, whenever a channel stops – either by clicking 
Stop  or when Playlist execution ends, the line sockets on 
the DSLA hardware are set on-hook.  However, you can 
disable this function should this not be desirable.  When 
‘AUTO ON-HOOK’ is disabled, this option appears 
dimmed. 

You can also force the line status to on-hook by right-
clicking ‘AUTO ON-HOOK’ and selecting ‘Go On-Hook’ 
from the pop-up menu. 

Sample Rate Sets the DSLA sample rate – either 8k or 16k.  When 16k is 
selected, the Channel A/B bandpass filter is forced to the off 
state. 

AB You can set both channels to start and stop together by 
enabling the ‘AB’ option.  When ‘AB’ is disabled, this 
option appears dimmed. 

Command line options 
The following command line options can be specified to control the DSLA application upon 
startup: 

Usage: medsla[ip].exe [/p refpath,degpath] [/s filepath] [s:/run filepath] 

 

Parameter Description 

/p refpath,degpath Use the /p option to execute the default speech quality assessment 
options on the specified reference and degraded files. 

/s[:run][:xxxx] filepath Use the /s option to load the specified schedule file. 
The following flags can used in conjunction with the /s option: 
:run Specify this flag to automatically start the Scheduler.  When 
the Scheduler has finished executing, the DSLA application will close. 
:xxxx Where xxxx is a dial string.  If specified, the first occurrence 
of a DTMF event in a Playlist will be substituted with this string. 

/fmt Use the /fmt option to erase all files and folders from DSLA memory. 
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Result log field definitions 
 

Heading Meaning Description 

DUR(s) Duration Test duration shown in seconds. 

LNGTRM Long Term Average level of the input signal.  This 
is a true RMS reading.  Expressed in 
the current units. 

ACTLVL Active Level Mean active speech level. Expressed 
in the current units. 

PEAK Peak Highest instantaneous level. Expressed 
in the current units. 

NSE Noise Noise level.  Expressed in the current 
units. 

ACT% Activity Factor Percentage of the total time where the 
mean active speech level is exceeded, 
i.e. speech is present.  

DLY Delay Delay in milliseconds of degraded 
signal with respect to the reference 
signal. 

DAF Dual Activity Factor Dual Activity Factor score. 

LE Listening Effort Listening effort score. 

LQ Listening Quality Listening quality score. 

OFFSET Time Offset Average of the utterance time offsets 
of the degraded signal with respect to 
the reference signal in milliseconds. 

CONF% Confidence Confidence in measurement of time 
offset.  Expressed as a percentage. 

MIN Minimum  Minimum utterance time offset in 
milliseconds. 

MAX Maximum  Maximum utterance time offset in 
milliseconds. 

STDDEV Standard Deviation The Standard Deviation of the 
utterance time offsets. 

UTTCNT Utterance Count Utterance count of the degraded signal 
– maybe more than the reference 
signal due to silence intervals in 
speech or time shifts in active speech. 

QLE Listening Effort Q  

QLQ Listening Quality Q 

MUTED% Proportion of Speech Muted 
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LNGMUTE Longest Muted Section 

PESQ PESQ Score PESQ MOS prediction 

PESQLQ PESQ Listening Quality Score PESQ MOS prediction transformed to 
LQ scale 

P.862.1 Score P.8621.Listening Quality Score PESQ MOS prediction mapped to 
LQO scale 

P.862.2 Score P.862.2 Listening Quality Score PESQ MOS prediction mapped to 
PESQ-WB scale 

 

FILEID Metric history file path The file path of the reference and 
degraded files. 

DATE/TIME Time when test completed  

Notes 
• All time values are expressed in milliseconds unless otherwise stated. 

• Some field values may be expressed as N/A.  This means that this field was not 
applicable for that particular result. 

 



 56 

Speech Quality Analysis 

Modern communications networks include elements, for example, lossy coding, error-prone 
channels and voice activity detection that cannot reliably be assessed by such conventional 
engineering metrics as signal-to-noise ratio. 

One way to measure customers’ perception of the quality of these systems is to conduct a 
subjective test involving panels of human subjects. However, these tests are expensive and 
unsuitable for such applications as real-time monitoring. Objective speech quality metrics are 
designed to predict the scores that would be obtained from subjective tests. 

The DSLA supports three speech quality metrics: 

 Perceptual Analysis Measurement System (PAMS) 

 Perceptual Evaluation of Speech Quality (PESQ ITU-T Rec. P.862) 

 Perceptual Speech Quality Measure (PSQM was ITU-T Rec. P861) 

PAMS Overview 
To measure speech quality, PAMS uses a sensory model to compare the original, unprocessed 
signal with the degraded version at the output of the communications system.  This process is 
shown in Figure 1 and determines Mean Opinion Score predictions, on a scale of 1-5, for the 
listening quality and listening effort.  The score calculated by PAMS will be typically within 
one half a MOS of that determined by a well controlled subjective test in a laboratory. 

Reference should be made to ITU-T Recommendation P.800 Methods for subjective 
determination of transmission quality for further information regarding the methods and 
procedures for conducting subjective tests. 

Listening tests are often conducted through telephone handsets and the bandwidth of the test 
material is adjusted appropriately. It may be necessary to filter the reference speech material 
to perhaps the Intermediate Reference System send characteristic (ITU-T Recommendation 
P.48) or some other characteristic to ensure that the reference and degraded signals are to be 
correctly compared.  The absence of such filtering may produce a significantly lower score 
than might be expected. 

The PAMS algorithm processes the reference and degraded speech to produce an auditory 
sensation surface for each.  These surfaces can be compared in a perceptually relevant manner 
to derive a number of error parameters.  Applying appropriate weighting to the error 
parameters and combining the results enables a MOS prediction to be made.  

PAMS incorporates many new developments that distinguish it from earlier codec assessment 
models such as those given in ITU-T P.861.  These innovations allow PAMS to be used with 
confidence to assess end-to-end speech quality as well as the effect of individual elements 
such as codecs. 

Release 3.0 of PAMS further extends the ability of the model to identify variable delay – 
characteristic of packet-based transmission systems – and introduces an equalisation process 
designed to enhance the robustness of PAMS with measurements made over connections 
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including analogue filtering.  This release also includes re-calibrated listening quality and 
listening effort mappings, as the subjective test database has been extended to include a wider 
range of distortion types. 

These developments provide PAMS release 3.0 with unparalleled accuracy at predicting 
quality across many different voice transmission technologies.  PAMS has been used 
successfully to assess conventional fixed and mobile networks as well as numerous packet-
based transmission systems. 

The DSLA and user interface have been designed to provide a simple access to this powerful 
algorithm, either directly from the analogue connection or from speech files recorded 
elsewhere. 

Figure 1: Usage of PAMS 
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Operations Performed by PAMS 
The processing carried out by PAMS is illustrated in Figure 2.  The model includes the 
following stages. 

Time Alignment 
PAMS is a listening model and has no knowledge of the delay of the system.  In order to 
compare the reference and degraded signals, however, they need to be lined up with each 
other.  Time alignment does this by dividing the signal into sections known as utterances, and 
finding the delay (time offset) of each section.  This enables it to cancel any bulk delay and 
most delay changes that might be caused by, for example, packet-based transmission. The 
DSLA has a delay of 4msec. This is accounted for in the delay measurements reported by the 
DSLA. The PAMS time offset measurements do not take account of the DSLA delay. This 
means that a time offset reported by PAMS on a file collected via the DSLA will be 4msec 
greater than that reported by the DSLA. 

Level Alignment 
Likewise, PAMS has no knowledge of level changes in the system.  It therefore assumes a 
constant listening level of approximately 79dB SPL [P.830], applying a gain to both the 
reference and degraded signals to bring them to this level. 
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Equalisation 
Analogue connections often introduce some degree of filtering.  For example, the send path of 
a telephone handset usually filters speech with a characteristic similar to the standard 
‘modified IRS send’ characteristic [P.830].  It is generally accepted that this has less effect on 
quality than coding distortions.  PAMS identifies any filtering that has taken place in the 
network and cancels its effect. 

Auditory Transform 
In order to compare the reference and degraded signals in a meaningful way – taking account 
of how a listener would have heard them – they are passed through an auditory transform that 
mimics certain key properties of human hearing.  This gives a representation in time and 
frequency of the perceived loudness of the signal, known as the sensation surface.  The 
difference between the sensation surfaces for the reference and degraded files is known as the 
error surface; this shows any audible differences introduced by the system under test. 

Error parameterisation 
The error surface is analysed in several different ways, for example calculating separately the 
average positive distortion (sounds added to the degraded signal) and the average negative 
distortion (e.g. parts of speech that have been attenuated).  This analysis gives a number of 
error parameters that summarise the amount of each type of audible error. 

Regression 
Finally, the error parameters are mapped onto predictions of perceived listening quality and 
listening effort.  These mappings are calculated and verified using a very large database of 
subjective tests to ensure that PAMS is able to predict quality for a wide range of distortion 
types. 

Figure 2: Processing performed in PAMS 
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Listening Effort and Listening Quality 
PAMS returns quality scores on two different opinion scales, Ylq (listening quality) and Yle 
(listening effort).  These scales are standard in the industry and are defined in [P.800].  They 
are reproduced in the table below, along with the prompt that is given to subjects.  Both Ylq 
and Yle scores lie between 1 and 5 and are usually quoted to two decimal places. 

The scores give a measure of customers’ perception of quality.  A PAMS score of 5 means 
that no distortion is measured.  As the amount of distortion increases the quality falls.  
Because they relate to different aspects of subjectivity, Yle and Ylq scores are normally 
different if there is perceived distortion; Yle is usually higher than Ylq.  

 Listening Quality Listening Effort 

5 Excellent Complete relaxation possible; no effort required 

4 Good Attention necessary; no appreciable effort required 

3 Fair Moderate effort required 

2 Poor Considerable effort required 

1 Bad No meaning understood with any feasible effort 

PAMS Metric Controls 

Modified IRS send filter 
From release 3.0, PAMS includes the ability to autodetect whether the distorting system 
includes an MIRS send filter.  This should be the default behaviour and it is recommended 
that users do not change this. 

The MIRS send filter represents the transfer function from mouth to junction in a fixed 
network telephone handset [P.830].  This provides a boost of about 6dB to high frequencies 
and strongly attenuates below 300Hz.  Applying this characteristic before speech enters the 
network controls the dynamic range and can improve intelligibility.  However, current mobile 
telephone handsets do not tend to follow the MIRS response and so this filter may be 
inappropriate in measured or simulated mobile conditions. 

The MIRS send filter on its own tends to have little subjective impact, so it is important that 
its effect is eliminated before the PAMS comparison.  To accomplish this, the filter is 
autodetected and applied if necessary, to the reference signal only, to equalise it to the 
degraded signal.  If the filter is detected incorrectly, for example due to noise in the degraded 
file, this behaviour may be overridden by specifying that the filter should, or should not, be 
included. 
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Transfer function estimation and equalisation 
The IRS send response is one example of a filter that may be encountered in a network.  
Filtering may occur at any analogue interface, and generally has limited subjective effect.  
However, PAMS tends to over-estimate the effect of filtering unless the reference signal is 
equalised to the degraded signal.  To address this, release 3.0 of PAMS includes a default 
option to perform identification of the filtering in the network and equalise the reference as 
required.  The method used is robust even in the presence of high levels of non-linear 
distortion such as channel errors. 

Receive acoustic filters 
One component of the auditory transformation used in PAMS is a filter which models the 
acoustic path from the junction, through a telephone receiver, and into the inner ear.  By 
default, this filter is applied to both the reference and degraded signals.  It is appropriate to 
omit this filter in two applications. 

Head and torso simulator (HATS) ear measurements will already have applied a similar 
characteristic as part of the acoustic path.  In this case, the receive acoustic filters should be 
included for the reference but omitted for the degraded file. 

Wideband telephony, operating at 16k sample rate, normally uses listening equipment that 
filters the signals much less strongly than a conventional narrowband receiver.  To model this, 
the receive acoustic filters should be omitted for both the reference and the degraded file. 

Transfer function estimation/equalisation should normally be left on in both of these 
applications. 

PAMS Results Returned 
PAMS calculates many parameters describing differences between the reference and degraded 
files.  These parameters are described in this section. 

Listening Quality Ylq 
PAMS returns a Ylq score designed to relate to the listening quality subjective opinion scale 
defined in P.800.  The PAMS score is continuous between 1 and 5.  A new mapping was 
introduced in release 3.0 and it is recommended that this is used for most measurement 
applications. 

The result of the old release 2.0 Ylq mapping is also calculated and may be available.  

In addition, two further quantities are derived, converting the release 3.0 Ylq scores to the 
equivalent Q domain on a dB scale.  The equivalent Q values may be used with Q domain 
models such as the E-model [G.107]. 

Note  
• The release 2.0 Ylq mapping will only be identical to those of PAMS release 2.0 if 

transfer function estimation/equalisation is disabled, which is not recommended. 
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Listening Effort Yle 
PAMS also provides a Yle score on the less-used listening effort scale.  This is also a new 
mapping in release 3.0.  Additionally, the release 2.0 Yle is calculated if transfer function 
estimation/equalisation is disabled, which is not recommended.  Listening quality is the 
dominant opinion scale in subjective testing; PAMS provides listening effort scores as this 
may be of value in testing systems for which intelligibility is more of a concern or where 
overall quality is generally low. 

Time Offset 
In order to deal with variable time offset, PAMS sub-divides the signal into a number of 
utterances.  Each utterance is time aligned separately.  The average of the time offsets is 
displayed along with the range and standard deviation. A graphical display of the utterance by 
utterance variation of time offset is shown. 

Utterance Count  
The number of utterances and segments that PAMS has determined in the degraded file. This 
may be more or less than expected if there has been some temporal clipping, delay changes or 
extensive silent intervals. 

Muting 
To assist with diagnosing systems in which muting (temporal clipping) is a distortion, two 
measures of muting – taking account of perceptual processes such as masking – are returned.  
Muting is the replacement of speech with silence or comfort noise. 

 Proportion of the speech that has been muted 

 Length in seconds of the longest muted part of speech 

Reference MIRS Send Filter Auto-Detection 
Applied if the bandwidth of the degraded signal is significantly less than that of the reference 
signal. 
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PESQ Overview 
PESQ provides an objective measure that predicts the results of subjective listening tests on 
telephony systems. To measure speech quality, PESQ uses a sensory model to compare the 
original, unprocessed signal with the degraded version at the output of the communications 
system. This process is shown in Figure 1 and is explained in more detail in the next section. 

The result of comparing the reference and degraded signals is a quality score. This score is 
analogous to the subjective “Mean Opinion Score” (MOS) measured using panel tests 
according to ITU-T P.800. The PESQ scores are calibrated using a large database of 
subjective tests. 

PESQ incorporates many new developments that distinguish it from earlier models for 
assessing codecs, for example, PSQM and MNB (ITU-T P.861). These innovations allow 
PESQ to be used with confidence to assess end-to-end speech quality as well as the effect of 
such individual elements as codecs. 

This is a fully conformant implementation of PESQ as defined in ITU-T P.862 with the 
mappings to P.862.1 LQO, P.862.2 PESQ-WB and  Ie. Additionally, it provides extensions to 
allow PESQ to be used with wideband telephony or head and torso simulator (HATS) 
measurements. 

The ITU-T selection process that resulted in the standardisation of PESQ involved a wide 
range of conditions, with demanding correlation requirements set to ensure that it has good 
performance in assessing conventional fixed and mobile networks and packet-based 
transmission systems. 

The DSLA and user interface have been designed to provide a simple access to this powerful 
algorithm, either directly from the analogue connection or from speech files recorded 
elsewhere. 

Figure 1: Usage of PESQ 

 
 

PESQ takes into account the following sources of signal degradation: coding distortions, 
errors, packet loss, delay and variable delay, and filtering in analogue network components. 

PESQ does not take into account the subjective effect of level changes in the network, echo, 
and the effect of round-trip delay on conversation. 
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Operations Performed by PESQ 
The processing carried out by PESQ is illustrated below. 

 
The model includes the following stages: 

Level alignment 
In order to compare the signals, the reference speech signal and the degraded signal should be 
at the same, constant power level. This is necessary because the reference signal does not 
have to be to be at a defined level and because the gain of the system under test is unknown 
before testing. 

PESQ assumes that the subjective listening level is a constant 79dB SPL at the ear reference 
point [ITU-T P.830, section 8.1.2]. A gain is applied to both the reference and degraded 
signals to bring them to this level. 

Input filtering 
Analogue connections often introduce some degree of filtering. For example, the send path of 
a telephone handset usually filters speech with a characteristic similar to the standard 
‘modified IRS send’ characteristic [ITU-T P.830]. It is generally accepted that this has less 
effect on quality than coding distortions do. PESQ compensates for any filtering that has 
taken place in the network. 

Time alignment  
The system may include a delay, which may be variable. In order to compare the reference 
and degraded signals, they need to be lined up with each other. PESQ is a listening model and 
has no knowledge of the delay of the system. PESQ applies voice activity detection to the 
signals to identify those parts of the signal that are speech, ignoring noise.  

Time alignment is then done in three stages: 

 First, PESQ aligns the overall speech signals (utterances). An utterance is a 
continuous speech burst identified by the voice activity detector. It may 
contain pauses that are no longer than a pre-determined threshold (200ms). 
This process detects delay over major sections of the degraded signal 
compared to the reference signal. 

 Second, PESQ aligns overlapping sections of the speech (frames). This 
process detects delay that is variable over the length of an utterance, as this 
can be significant in packet-based networks. 
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 There is also a third stage after the next operation (the auditory transform), in 
which “bad intervals” (sections of the speech with very large disturbance) are 
realigned. This step improves the model’s accuracy with a small number of 
files where delay changes are not correctly identified by the initial time 
alignment process. 

The DSLA has a delay of 4msec. This is accounted for in the delay measurements reported by 
the DSLA. The PESQ time offset measurements do not take account of the DSLA delay. This 
means that a time offset reported by PESQ on a file collected via the DSLA will be 4msec 
greater than that reported by the DSLA.  

Auditory transform 
In order to compare the reference and degraded signals, taking account of how a listener 
would have heard them, each is passed through an auditory transform that mimics certain key 
properties of human hearing. This gives a representation in time and frequency of the 
perceived loudness of the signal, known as the sensation surface. 

Disturbance processing 

The difference between the sensation surfaces for the reference and degraded files is known 
as the error surface; this shows any audible differences introduced by the system under test. 
The error surface is analysed by a process that takes account of the effect that small 
distortions in a signal are inaudible in the presence of loud signals (masking). 

From the positive and negative errors, two disturbance parameters are calculated. They are 
calculated as non-linear averages over specific areas of the error surface. These disturbance 
parameters are: 

 the absolute (symmetric) disturbance – a measure of absolute audible error 

 the additive (asymmetric) disturbance – a measure of audible errors that are 
significantly louder than the reference 

This analysis gives two error parameters that summarise the amount of each type of audible 
error. Finally, the error parameters are converted to a quality score, which is a linear 
combination of the average symmetric disturbance value and the average asymmetric 
disturbance value. 
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PESQ Quality Scores 
PESQ returns a quality score on the listening quality scale, which is standard in the industry 
and is defined in [ITU-T P.800]. This is reproduced in the table below, along with the prompt 
that is given to subjects. Listening quality scores lie between 1 and 5, but the PESQ score 
does not exceed 4.5, as this is usually the maximum obtained in a subjective test. 

Score Quality of the Speech 

5 Excellent 

4 Good 

3 Fair 

2 Poor 

1 Bad 

The score gives a measure of customers’ perception of quality. The highest PESQ score, 4.5, 
means that no distortion is measured. As the amount of distortion increases the quality falls. 

Several alternative mappings of the PESQ raw score have been developed to attain a better 
correlation with subjective test. 

PESQ-LQ 
PESQ-LQ has many advantages over the standard PESQ score provided by P.862. PESQ-LQ 
is closer to subjective MOS. PESQ-LQ is on a 1–5 scale, the same range as MOS.  (Note that 
PESQ-LQ is limited to a maximum of 4.5 as MOS is seldom greater than this.) 

On average, over a large number of subjective tests, PESQ-LQ relates closely to subjective 
MOS.  This is shown by Error! Reference source not found., which plots subjective MOS 
compared with PESQ-LQ for 11 subjective tests.  The solid line in this graph shows the ideal 
one-to-one relationship. 

P.862.1 Score 
The aim of separate recommendation ITU-T P.862.1 is to provide a single mapping from raw 
P.862 score to the Listening Quality Objective Mean Opinion Score (MOS-LQO). 

P.862.2 Score 
The aim of separate recommendation ITU-T P.862.2 is to provide a single mapping from raw 
P.862 score to the Listening Quality Objective Mean Opinion Score (PESQ-WB). 



 66 

 

Summary 
 The P.862.1 mapped score is a function that maps more closely to subjective 

MOS according to the ACR LQ method defined in ITU-T P.800/P.830. 

 Subjective MOS does vary from test to test, but PESQ-LQ is a good predictor 
of MOS taking account of a large number of subjective tests. 

 Results obtained with PESQ will vary from PAMS, PSQM, etc.  PESQ is the 
most accurate. 

PESQ Metric Controls 
The models that PESQ can implement are: 

 Standard P.862 (narrowband handset on reference and degraded signals) raw 
score 

 HATS ear recording on degraded signal, unprocessed (wideband) reference 
signal 

 Wideband model (headphone listening) and P.862.2 mapped score 

 PESQ LQ mapped score 

 P.862.1 mapped score 

The default for narrowband measurements is the P.862 raw score and P.862.1 mapped score. 

PESQ Input Filters 
Depending on the choice of model, PESQ determines internally which input filter to apply. 

In the standard narrowband PESQ measurements, a frequency-domain input filter is applied 
to both the reference and degraded files before time alignment and psychoacoustic processing. 
The filter used, which is similar to the modified IRS receive filter specified in P.830, is shown 
in Figure 2.  This approximates the filter characteristic of a standard handset. 
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For wideband measurements, a more appropriate filter is used with a flat response above 
100Hz and a gentle roll-off below this point, modelling the attenuation of the headphones and 
ear at low frequencies. The filter uses a simple IIR implementation. The response of the 
16kHz implementation is shown in Figure 3. The 8kHz implementation has the same gain 
(within 0.1 dB) in the 1Hz–4kHz range. 

For HATS measurements using a telephone handset, the standard narrowband input filter is 
applied to the reference (to model a standard handset), but the wideband filter is applied to the 
degraded file as the HATS recording will automatically include the handset path. 

Figure 2: PESQ narrowband input filter characteristic 

 

  Figure 3: PESQ wideband input filter characteristic 

 

Table of PESQ Filter Options 

Option Default Model 

Reference Acoustic Filter On 

Degraded Acoustic Filter  On 
Standard P.862 Narrowband model 

Reference Acoustic Filter  On 

Degraded Acoustic Filter Off 

Wideband reference signal  
HATS ear recording 

Reference Acoustic Filter  Off 

Degraded Acoustic Filter Off 
Wideband model for reference and degraded signals 
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PESQ Results Returned 

PESQ Score 
PESQ returns a quality score on the listening quality scale, which is standard in the industry 
and is defined in [ITU-T P.800].  The range of the score is from 4.5 to 1. 

PESQ-LQ Score 
PESQ-LQ Score is a function that maps more closely to subjective MOS 

P.862.1 Score 
P.862.1 score is a function that maps more closely to subjective MOS in the narrowband 
condition. 

P.862.2 Score 
P.862.2 Score is a function that maps more closely to subjective MOS when the wideband 
model is used. 

Time Offset 
In order to deal with variable delay, PESQ sub-divides the signal into a number of utterances. 
Each utterance is time-aligned separately. The average of the time offsets is displayed along 
with the range and standard deviation. A graphical display of the utterance by utterance 
variation of time offset is shown. 

Frame-by-frame delay 
Frame-by-frame delay is the delay measure used in calculating the PESQ quality score. 
Utterances are broken up into frames of 32 ms duration. Frames use a window function that 
gives greater weight to the central 16ms of each frame, and there is an overlap between 
successive frames of 50%. Effectively, therefore, each frame is 16ms long; this can be 
thought of as “sampling” the values every 16ms. PESQ calculates the delay in each frame, 
based on the nearest utterance. 

The frame-by-frame delay is the best way of tracking how delay varies during the signal. This 
processing ensures that insertions into the degraded signal are ignored, and deletions from the 
signal are partially ignored. 

Utterance Count  
The number of utterances that PAMS has determined in the degraded file. This may be more 
or less than expected if there has been some temporal clipping or extensive silent intervals. 
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Perceptual Speech Quality Measurement 
The implementation of PSQM is based upon ITU-T Rec. P.861. The algorithm and 
functionality are described in P.861 and not repeated here. 

The silent interval weighting factor (Wsil) can be set to 0, 0.2, 0.4, 0.6, 0.8, or 1.0. The usual 
setting is 0.2 as described in P.861 9.5.4 Note 2. The setting of the silent interval weighting 
factor (Wsil) significantly affects the PSQM value. 

The mapping of the PSQM value to Mean Opinion Score or MOS is described in P.861. 0 is 
equivalent to excellent and 6.5 is bad on the Listening Quality Scale defined in ITU-T Rec. 
P.800. For simplicity, a linear mapping has been employed. 

PSQM Value 0    = MOS LQ 5 
PSQM Value 6.5 = MOS LQ 1 

So, MOS LQ = 5 – (4 * PSQM / 6.5) 

PSQM   0 1 2 3 4 5 6 6.5 
MOS  5.00 4.38 3.77 3.15 2.54 1.92 1.31 1.00 

Other mappings may be more appropriate. Other PSQM implementations on other platforms 
may well use different mappings leading to different MOS. The use of different Wsil will lead 
to differences in PSQM values. 

Note that the PSQM values that are returned by DSLA for packet based networks may be 
better than other implementations of PSQM on other platforms. This is because the DSLA 
uses superior techniques for time and level alignment. The PSQM values should be consistent 
across platforms for non-time varying networks.  

The PSQM and mapped MOS results are presented for the Wsil value selected when the 
PAMS process is called. The results are written to the results.log file if selected in Options 
dialog box (Tools|Options|Results). The MOS value may be similar to the LQ value reported 
in the PAMS window. There may be differences due to the types of distortion that have been 
applied to the degraded signal. The limitations of PSQM, designed as a codec evaluation tool, 
when used in network tests have been described elsewhere. 
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PAMS – Speech Quality Analysis Display 
Menu: View|PAMS 
 

 
 
Using the PAMS display window you can: 

 View 2D and 3D views of the PAMS sensation surfaces. 

 Zoom, playback and re-analyse surface views. 

 Display utterance markers. 

 Save surface views as a Bitmap file for importing into a word processor etc. 

 View graphical plots for transfer function, signal spectra and utterance time 
offsets. 

 Execute the PAMS process on your own sound files. 

About the PAMS Display 

Sensation surface and error surface views 
The sensation surfaces show the perceived loudness, on the phon scale, of the signals in time 
and frequency.  The frequency scale is the Bark scale, and the time interval between 
successive samples is 4ms.  The sensation surfaces are very useful, clearly showing the 
signals’ content. 

The difference between the sensation surfaces of the reference and degraded speech is the 
error surface.  This means that errors that have added to the signal (for example, noise) have 
positive values and appear in the top error surface view, while parts of the signal that have 
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been attenuated or muted have negative values and can be seen clearly below the error 
surface.  The magnitude of the error is related to how audible and annoying it will be.   

Examination of the error surface can provide useful insights into the degradation that has 
occurred.  Noise will show as a positive error in the silences between utterances.  Degradation 
due to a voice activity detector will probably appear as negative excursions in the error 
surface at the beginning of an utterance.  High frequency loss can be seen in the three 
dimensional view.  

The 2D view of the time aligned reference, degraded and error surfaces show the following 
properties clearly:- 

 Front-end clipping causes large but short negative errors at the start of speech 
bursts. 

 Muting can be seen as prolonged negative errors during speech, where the 
degraded sensation surface falls close to zero. 

 Addition of background noise shows up as positive errors, and is most 
apparent in silent periods. 

 Coding distortion generally causes low-level errors throughout speech bursts, 
although this is very codec-dependent. 

 Bit or frame errors tend to cause localised distortion, which may be positive or 
negative.  This effect is dependent on the codec and any error concealment 
algorithm used. 

Transfer function and signal spectra views 
Even if equalisation is disabled, the system’s transfer function and the spectrum of the 
reference and degraded signals are computed.  All of these quantities are calculated in dB for 
each of the 19 frequency bands. 

If the IRS send filter is auto-detected, it is applied to the reference signal before the transfer 
function is calculated and so will not be part of the transfer function estimate. 

Utterance time offset view 
The distribution of utterance time offsets clearly shows how the speech transmission 
performance is being affected by variations in packet arrival time or jitter buffer resizing. 
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Using the PAMS – Speech Quality Analysis Display 

Selecting a view 
1. Open the PAMS – Speech Quality Analysis Display window (View|PAMS). 

2. Click the Display tab. 

3. Select the required view from the View list box. 

Analysing an area of the display 
1. Select the area you wish to analyse by dragging over the display with the left mouse 

button held down to highlight the required area. 

2. Right-click the display and then click Selection|Analyse. 

Note 
• The analysed area will start from the beginning of the nearest utterance start point to 

the end of the nearest utterance end point. 

Listening to an area of the display 
1. Select the area you wish to listen to by dragging over the display with the left mouse 

button held down to highlight the required area. 

2. Right-click the display and select Selection|Play. 

Zooming the view 
1. Select the area you wish to zoom by dragging over the display with the left mouse button 

held down to highlight the required area. 

2. Right-click the display and select Selection|Zoom. 

3. Restore a zoomed area by right-clicking the display and selecting Restore View. 

Changing the degraded sensation surface display options 
1. Right-click on the display, and then click, Degraded Display Options. 

2. Select an option from the menu. 

Saving the view as a Bitmap 
1. Right-click on the display and click, Save Image As. 

2. To save the image in a different folder, click a different drive in the Save in box, or 
double-click a different folder in the folder list. 

3. In the File name box, type a name for the document. 

4. Click Save. 



 73

PESQ – Speech Quality Analysis Display 
Menu:  View|PESQ 
 

 
 
Using the PESQ display window you can: 

 View 2D and 3D views of the PESQ sensation surfaces. 

 Zoom, playback and re-analyse surface views. 

 Display utterance markers. 

 Save surface views as a Bitmap file for importing into a word processor etc. 

 View graphical plots for transfer function and utterance time offsets. 

 Execute the PESQ process on your own sound files. 

About the PESQ Display 

Sensation surface and error surface views 
The sensation surfaces show the perceived loudness, on the Sone scale, of the signals in time 
and frequency.  The frequency scale is the Bark scale, and the time interval between 
successive samples is 16ms.  The sensation surfaces are very useful, clearly showing the 
signals’ content. 

An alternative view of the power distribution in different frequency bands provides a more 
useful representation of the signal. 
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The difference between the sensation surfaces of the reference and degraded speech is the 
error surface.  This means that errors that have added to the signal (for example, noise) have 
positive values and appear in the top error surface view, while parts of the signal that have 
been attenuated or muted have negative values and can be seen clearly below the error 
surface.  The magnitude of the error is related to how audible and annoying it will be.   

Examination of the error surface can provide useful insights into the degradation that has 
occurred.  Noise will show as a positive error in the silences between utterances.  Degradation 
due to a voice activity detector will probably appear as negative excursions in the error 
surface at the beginning of an utterance.  High frequency loss can be seen in the three 
dimensional view.  

The 2D view of the time aligned reference, degraded and error surfaces show the following 
properties clearly:- 

 Front-end clipping causes large but short negative errors at the start of speech 
bursts. 

 Muting can be seen as prolonged negative errors during speech, where the 
degraded sensation surface falls close to zero. 

 Addition of background noise shows up as positive errors, and is most 
apparent in silent periods. 

 Coding distortion generally causes low-level errors throughout speech bursts, 
although this is very codec-dependent. 

 Bit or frame errors tend to cause localised distortion, which may be positive or 
negative.  This effect is dependent on the codec and any error concealment 
algorithm used. 

Transfer function  
Even if equalisation is disabled, the system’s transfer function and the spectrum of the 
reference and degraded signals are computed.  All of these quantities are calculated in dB for 
each of the 42 or 49 frequency bands. 

Utterance time offset view 
The distribution of utterance time offsets clearly shows how the speech transmission 
performance is being affected by variations in packet arrival time or jitter buffer resizing. 
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Using the PESQ – Speech Quality Analysis Display 

Selecting a view 
1. Open the PESQ – Speech Quality Analysis Display window (View|PESQ). 

2. Click the Display tab. 

3. Select the required view from the View list box. 

Analysing an area of the display 
1. Select the area you wish to analyse by dragging over the display with the left mouse 

button held down to highlight the required area. 

2. Right-click the display and then click Selection|Analyse. 

Note 
• The analysed area will start from the beginning of the nearest utterance start point to 

the end of the nearest utterance end point. 

Listening to an area of the display 
1. Select the area you wish to listen to by dragging over the display with the left mouse 

button held down to highlight the required area. 

2. Right-click the display and select Selection|Play. 

Zooming the view 
1. Select the area you wish to zoom by dragging over the display with the left mouse button 

held down to highlight the required area. 

2. Right-click the display and select Selection|Zoom. 

3. Restore a zoomed area by right-clicking the display and selecting Restore View. 

Changing the degraded sensation surface display options 
1. Right-click on the display, and then click, Degraded Display Options. 

2. Select an option from the menu. 

Saving the view as a Bitmap 
1. Right-click on the display and click, Save Image As. 

2. To save the image in a different folder, click a different drive in the Save in box, or 
double-click a different folder in the folder list. 

3. In the File name box, type a name for the document. 

4. Click Save. 
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Using DSLA to Analyse Speech Quality 
When using Speech Quality Analysis with the DSLA, a degraded signal is recorded by the 
DSLA using a Playlist script.  The degraded file is then compared with a reference file(s) 
stored on your PC’s hard disk.  The reference file(s) can be either the ASTS speech set, or 
your own WAV formatted files. 

Example Playlist implementation using Speech Quality Analysis 

1. Create a Playlist on Channel A which contains the following events: 

Step Type Description 

1  Start Measurement [A] - PAMS Example 

2  Speech element 1 

3  Speech element 2 

4  Speech element … 

5  Wait [00:00:01:00] 

6  PAMS from Step 2, REC = A 

2. Set the Wait event Duration property to 1 second - this event allows any network delay 
to be taken into account. 

3. Set the Speech Quality Analysis event Start measuring from Step property to the event 
index of the first speech element. 

4. Set the Speech Quality Analysis event Record from Channel property to the channel 
which is to receive the input – or degraded signal. 

5. On the Channel A window toolbar, click Start  

Notes 
• Your reference files must exist within the default Phonytalk folder as defined in 

Tools|Options|General and must also be copied to DSLA memory and placed within 
the same folder hierarchy.  
 
Examples: (default folder path set to: ‘c:\programs\dsla\phonytalk’) 

Local file path DSLA file path 

c:\programs\dsla\phonytalk\file1.wav dsla:\file1.wav 
c:\programs\dsla\phonytalk\sub-folder\file2.wav dsla:\sub-folder\file2.wav 

• Do not use more than 15 seconds of speech or the record buffer will lose the earlier 
material. 

• There must be at least 4 seconds of speech for either PAMS or PESQ to produce a 
prediction. 

• Add a short wait period before the Speech Quality Analysis statement to allow for 
network delay. 

• An Ethernet connected DSLA will replay and recover speech of any duration, limited 
only by the hard disk space.  

• There is a fifty utterance limit for Speech Quality Analysis.  
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Analysing Speech Quality Using Your 
Own Sound Files 
Speech Quality Analysis can be used to process any WAV or headerless (RAW), mono 
channel, 8/16k, sound files. 

1. Open a Speech Quality Analysis window.  

2. Select the Manual Input tab. 

3. Enter the file paths for the reference and degraded files, or select a previously used file 
from the drop-down lists. 

4. Click OK. 

Notes 
• The DSLA must be connected to the PC for the process to be enabled. 

• If using headerless (RAW) files, be sure to define the format you are using. 
(Tools|Options|Speech Quality Analysis|Sound File Data Format). 

• There must be at least 4 seconds of speech for Speech Quality Analysis to produce a 
prediction. 

• You can preview a file listed in the file path boxes by clicking Preview.   

16k Sample Rate Operation 
16k sample rate sound files can only be used with Ethernet DSLA using an IP connection.  
There is sufficient memory in DSLA for about 35 seconds of 16k sample rate speech 
files.This allows all of the 16k ASTS files from either the IRS or SP folder to exist in DSLA 
memory, but not both together. There is sufficient memory in DSLA II for about 130secs of 
16k sample rate speech files. 

When using a Playlist that includes a speech quality analysis test using more than 8 seconds 
of speech, DSLA will stream the degraded file back to the PC, therefore sufficient Ethernet 
bandwidth must be available between DSLA and the PC. 

The 16k sample rate ASTS is installed in the <InstallPath>\Phonytalk\16k folder.  Create an 
American or British folder in the root of DSLA and download the appropriate ASTS files. A 
Playlist calling these files will automatically use 16k versions of the files in this folder or in 
the DSLA if the sample rate is set to 16k on the status bar or by the schedule. This means that 
your existing Quick Start schedules and Playlists can be used without making any changes to 
them. 

When you select 16k in the DSLA status bar then only those files in DSLA that are 16k 
appear in the DSLA Explorer window. You can add 16k sample rate versions of your own 
speech files to the 16k folder in the same structure as existed in the Phonytalk folder for the 
8k versions and, if there is sufficient space in memory, download them to DSLA. 

Both 16k and 8k files can exist in the same folder in DSLA, even though they are in the 
Phonytalk /16k and Phonytalk folders respectively. Switching DSLA between 8k and 16k 
gives access to the different sample rate files. 
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Note that selecting 16k in the DSLA status bar forces the channel bandpass filter to the off 
state. The channel bandpass filter is useful for speech level measurements but the attenuation 
of high and low frequencies in the degraded file shows a significant mean opinion score 
impairment at 16k sample rate. 

You can create 16k schedule tasks or 8k schedule tasks or leave the task undefined so that it is 
controlled by the DSLA status bar. Each schedule task has a 16k/8k property in the Channel 
Properties tab.  Schedules created by earlier versions of the DSLA User Interface (<3.70) will 
assume the 16k/8k status in the DSLA status bar when they are executed. If such a schedule is 
saved it will not have a 16k/8k property unless it has been set by the user. If you wish to 
create new schedules that will work with either 16k or 8k speech files, depending upon the 
DSLA status bar status, do not set the schedule task 16k/8k property.   

Alternatively, you can specify file paths to 8k files or to 16k files in Playlists and define the 
16k or 8k sample rate in the Channel Properties tab in each schedule task. Sample rates 
cannot be mixed in a Playlist. 

16k sample rate Intermediate Reference System send characteristic ASTS files are supplied 
(IRS folder) along with flat response files (SP folder). You can use the IRS files with any 
telephone network.  

The SP files should only be used with artificial mouth or where DSLA is directly connected 
to a wideband telephony or communications system. If the degraded signal is recorded 
through a HATS artificial ear, then the degraded acoustic filter should be unchecked in the 
Speech Quality Metric Control, either manually in the Speech Quality Metrics properties 
window or via the schedule task Metric Control tab. This control will be applied to both 
PAMS and PESQ if you are using both and selects the appropriate model in the speech 
quality metric for HATS ear recording. 

The speech quality metric settings should be changed where the signal is to be received by a 
wideband communication device employing headphones for listening (PC to PC speech 
communications, for example). Both the reference and the degraded acoustic filters should be 
unchecked in the Speech Quality Metric Control, either manually in the Speech Quality 
Metrics properties window or via the schedule task Metric Control tab. This control will be 
applied to both PAMS and PESQ if you are using both and selects the appropriate model in 
the speech quality metric for wideband telephony. The P.862.2 score will be reported instead 
of P.862.1. 

 

Speech path Source Speech Material PESQ/PAMS  
Degraded acoustic filter 

h/free mic jack>GSM>base IRS ON 

Base>GSM>h/free e/p jack IRS ON 

Mouth>GSM>base SP, Equalised for Mouth ON 

Base>GSM>Microphone IRS* ON 

HATS mouth>GSM>base SP, Equalised for Mouth ON 

Base>GSM>HATS ear IRS* OFF 
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* Unless IRS filtering is applied in the audio module of the base station emulator, in which 
case use SP. 
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Typical Subjective Test Scores for 
Various Codecs 
 

Coder Type Application Standard Typical 
MOS(LQ) 

Bit Rate 
kb/s 

LPC vocoder Secure Telephony FS-1015 2.36 2.4 

PSI-CELP Cellular PDC HR 3.51 3.45 

IMBE Satellite IN-M 3.19 4.15 

CELP Secure Telephony FS-1016 3.09 4.8 

MPC-MLQ & 
ACELP 

Compression G.723.1 4 6.3 

MPC-MLQ & 
ACELP 

Compression G.723.1 3.51 5.3 

VSELP Cellular GSM HR 3.51 5.6 

VSELP Cellular PDC 3.51 6.7 

CS-ACELP Cellular IS641 4.04 7.4 

VSELP Cellular IS54 4.54 7.95 

CS-ACELP Compression G.729 4.04 8 

CELP Cellular IS96 3.5 8.5 

Multipulse LPC Satellite AMTS 3.24 9.6 

RPE-LTP Cellular GSM 3.56 13 

LD-CELP Compression G.728 4.05 16 

ADPCM Compression G.726 4.05 32 

ADPCM Compression G.727 4.05 32 

Companded PCM Compression G.711 4.17 64 
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Calibration 

The DSLA has a three year calibration cycle. Calibration can only be performed by Malden 
Electronics Ltd. Contact us  to arrange the return of the unit. It will be tested and re-calibrated 
if necessary. A new calibration certificate will be returned with the unit. 

It is easy to verify that the DSLA is still in calibration. It is a true RMS voltmeter, so you can 
compare its measurements of a sinusoidal waveform with those of another measuring 
instrument that is in calibration. Similarly, the sine wave output levels and frequencies can be 
verified with a known good instrument. The speech level determination is performed in 
software and is based upon the signals observed at the A/D converter. If the sine wave 
measurements are correct then the speech level measurements must be as well. 
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Frequently Asked Questions 

Q. What type of cable is required to connect my PC to the DSLA? 
A. You need to use a ‘straight through’ (extension) serial cable. 

Q. What is the minimum pin connections required for the serial cable? 
A. PC (9 way) PC (25 way) DSLA  

2   3   2 
3   2   3 
5   7   5 

Q. What is the meaning of the Offset Confidence figure shown in the PAMS ‘Results’ display, or 
displayed in the Channel status bar when using the ‘Delay – Time Align’ event? 

A. The confidence figure is a percentage value, showing the reliability of the delay or offset figure that 
has been calculated. It is proportional to the number of points that have been matched successfully. 

Q. What does the colour scaling indicate in the PAMS window? 
A. It allows you to differentiate the differences between signal levels at different times – particularly in 

the 3D views of the auditory sensation surfaces.  Signal energy is indicated from blue – low signal 
energy, to red – high signal energy. 

Q. What is the difference between the SP and IRS speech sets? 
A. The SP speech set contains utterances that are flat to 4kHz and are ideally suited for use where a 

wide bandwidth signal is expected.  i.e.  Into a standard mouth acoustically coupled to a 
microphone.  The IRS speech set contains utterances that are bandwidth limited using the 
Intermediate Reference System Send characteristic (ITU-T Recommendation P.79) and are ideally 
suited for direct injection into the telephone network. 

Q. Can I automatically suppress error messages that may appear whilst running an automated 
test sequence? 

A. Yes.  Open the Options dialog box (Tools|Options) and select the ‘Suppress and Log Error 
Messages’ option found in the ‘General’ options page. 

Q. Where can I get the latest version of the DSLA software? 
A. For the latest DSLA software updates and information, visit our website at: http://www.malden.co.uk 
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DSLA Block Diagram 
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Glossary of Terms and 
Abbreviations 

BABT The British Approvals Board for Telecommunications 

ITU The International Telecommunications Union 

IEEE Institution of Electrical and Electronic Engineers 

P.48 ITU Recommendation P.48.  Specification for an Intermediate Reference 
System (IRS). 

P.56 ITU Recommendation P.56 for Objective Measurement of Active Speech 
Levels Method B. 

P.800 ITU Recommendation P.800 for Subjective determination of 
Transmission Quality. 

P.830 ITU Recommendation P.830 for Subjective performance assessment of 
telephone-band and wideband digital codecs 

P.861 ITU Recommendation P.861 for Objective quality measurement of 
telephone-band codecs (300-3400 Hz) 

P.862 ITU-T Recommendation P.862 for Perceptual Evaluation of Speech 
Quality (PESQ), an objective method for end-to-end speech quality 
assessment of networks and speech codecs 

dB Decibel 

RMS Root-Mean-Square. 
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Contacting  
Malden Electronics Ltd 

Malden Electronics Ltd 
2 High Street, 
Ewell, 
Surrey, 
KT17 1SJ, England 
 
Tel: 020 8786 9145 International: + 44 20 8786 9145 
Fax: 020 8393 6883 International: + 44 20 8393 6883 
 

Web: www.malden.co.uk 

Technical Support 
Before contacting Technical Support, you should check this manual.  If you still cannot solve the 
problem, you can obtain product support in several ways:  

Telephone: 020 8786 9145 
 

Email: Ask questions and receive answers from Technical Support via the Internet. Just send email 
addressed to the account listed below. You will receive a reply via email.  

support@malden.co.uk 

 


